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What’s New in ChemStation B.02.01?

• New and improved user interface design

• New tree- and table-based navigation provides fast and flexible data 
handling within various ChemStation views

• Flexible storage locations for data, methods, and sequences

• Improved data review and reprocessing capabilities using the Data Analysis 
Navigation Table

• New packaging concept guarantees consistency for sequence data

• Additional signal options allow you to assign method-specific signal options 
to improve data review

• Option to save manual integration events in a Data Analysis method along 
with newly acquired data files

• ChemStation tutorial integrated with online help allows you to learn the 
software while working on your own methods and data

• Enhanced utilization of high-resolution monitors and available screen 
space

• Support for Agilent 6100 Series Quad LC/MS Systems
Agilent Technologies



Where to find more information
Where to find more information

Use the following resources to learn how to use your Agilent 6100 Series 
LC/MS system.

Online Help

Use the online help for in-depth information not given in this Quick Start 
Guide. Display online help in any of the following ways:

• Click the Help button in the toolbar.

• Select Help Topics from the Help menu.

• Click the Help button on most dialog boxes to display task-specific help.

Manuals

The following manuals are shipped with your system and are also available in 
PDF format.

• Agilent 6100 Series Quad LC/MS Systems Quick Start Guide (G1960-90001)

• Agilent 6100 Series Quad LC/MS Systems Installation Guide 
(G1960-90002)
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Configuration Diagrams
Configuration Diagrams

1100 or 1200 Series LC

Solvent bottles

LC Detector 
(DAD or VWD)

Control module
(optional)

Vacuum degasser

Pump

Solvent cabinet

Column 
compartment

Autosampler
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Configuration Diagrams
LC Cabling

Remote cable

CAN bus cable

AC power

Shielded LAN cable 
to network hub

CAN bus cable

Analog signal 
to recorder
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ChemStation Views
ChemStation Views

The LC/MS Quad ChemStation software consists of the following views: 
Method and Run Control, Data Analysis, Report Layout, Verification (OQ/PV), 
Diagnosis, and MSD Tune. The menu items and toolbar buttons depend on the 
current view. Each view allows you to perform a certain set of tasks.

Switch to a different view by clicking one of the view buttons in the lower left 
corner of the screen (shown below).

You can also select a different view from the View menu.

Method and Run Control View

In this view, you can set up methods and adjust instrument parameters to 
inject samples and acquire data one sample at a time or in automated 
sequences.

Data Analysis View

In this view, you can perform various data evaluation tasks on chromatograms 
and spectra. You can view both mass spectral and UV signals simultaneously. 
Common tasks include integration, quantitation, checking peak purity, and 
deconvolution. Once you have analyzed the data, you can select one of the 
predefined report types.

Report Layout View

In this view, you can design custom report templates to use with the data 
generated by your ChemStation.
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ChemStation Views
Verification (OQ/PV) View

In this view, an Agilent service engineer can determine if your system is 
operating in a predictable manner. This is useful to show Good Laboratory 
Practice (GLP) compliance and may be required by some government agencies.

Diagnosis View

In this view, you can run tests to diagnose instrument problems and access 
information on how to resolve these problems. The early maintenance 
feedback (EMF) feature can be used to notify you when it is time to perform 
system maintenance before a problem occurs.

MSD Tune View

In this view, you can calibrate your LC/MS quad automatically. You can also 
set MS parameters manually for specific types of molecules.
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ChemStation Views
Method and Run Control View

Title Bar

View Selection

Tool Set Selection

Message Line

Start/Stop Run

Sampling Diagram

Top Toolbar System 
Diagram

Status Bar

Online Plot

Method Overview

File List

Method Sequence
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ChemStation Views
System Diagram Each icon of the system diagram represents one component or module of your 
system. Click on an icon if you want to edit the method parameters or go to the 
online help for that particular component.

Single Sample
Tool Set

This toolset allows you to work on methods and run an analysis for a single 
sample. Move the cursor over a button to view a description of it.

Sequence
Tool Set

This toolset allows you to work on sequences and run automated analyses of 
multiple samples. Move the cursor over a button to view a description of it.

Method Pump Column Detector

DetectorInjector Solvent Integration

Calibration

Reporting

Click the Single Sample icon to display this toolset.

Click the Sequence icon to display this toolset. The sampling diagram 
now shows the sample tray. 

FIA
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ChemStation Views
Flow Injection
Analysis (FIA)

This toolset allows you to inject multiple samples directly into the detector, 
bypassing the chromatographic column. The results are sent to a single data 
file. FIA can be used for method development or for applications that do not 
require chromatography.

To enable FIA from the system diagram:

• Click the FIA icon.
• Select Edit FIA Series.
• Check the Enable FIA Series in Method box and edit the 

FIA Table.
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ChemStation Views
Data Analysis View

Common Tool Set

This toolset is always present in Data Analysis view. Move the cursor over a 
button to view a description of it.

Title Bar

Display 
Graphics 
Tools

Tool Set Selection

Cursor Tools

Signal View Selection

DAD Signal

LC/MS quad Signal

Message Line

View Selection

Navigation Tools

File List
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ChemStation Views
Graphics Tool Set

This toolset allows you to manipulate the graphic display. Move the cursor 
over a button to view a description of it.

Click the Graphics icon to display this toolset, which appears on the right side of the plot window.
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ChemStation Views
Integration Tool Set

This toolset allows you to perform integration and reporting tasks on a 
chromatogram. Move the cursor over a button to view a description of it.

Calibration Tool Set

This toolset allows you to perform calibration tasks for quantitation. Move the 
cursor over a button to view a description of it.

Click the Integration icon to display this toolset.

Click the Calibration icon to display this toolset.
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ChemStation Views
Signal Tool Set

This toolset allows you to graphically work with the UV or MS signal. Move the 
cursor over a button to view a description of it.

Purify Tool Set

This toolset allows you to graphically work with your purification data.

Spectral Tool Set

This toolset allows you to perform spectral evaluation tasks. Move the cursor 
over a button to view a description of it.

Click the Signal icon to display this toolset.

Click the Purify icon to display this toolset.

Click the Spectrum icon to display this toolset.
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ChemStation Views
Report Layout View

Report Layout Tool Set

This toolset is present in the Report Layout view. Move the cursor over a 
button to view a description of it.

Report Layout Tips

• Edit or create a report layout as described in the online help.

• To test your report layout, select a calculation technique from the 
drop-down list box to define how the results should be calculated. 

• Load a data file. The results are loaded into the report template using the 
selected calculation.

• Select File / Add to Report Styles to add your completed report template 
to the list of available report styles. Now you can use your customized 
report within a method.

Title Bar

View Selection

New Section Menu

Message Line

Report Template Calculation Technique

Report SectionInsertion Triangle

Click a blue triangle to activate 
the new section menu (triangle 
turns red)

Toolbar
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ChemStation Views
Sample Report Layouts (in \hpchem\repstyle)

Template Description

SIMPLE.FRP Includes a chromatogram and calibration curves per calibrated 
compounds.

NESTED.FRP Shows how to nest subsections.

SPECTRA.FRP Shows how to include spectra.

PURITY.FRP Shows how to include peak purity data.

ESTD.FRP Uses the same elements as the standard ESTD reports so you can 
customize your external standard reports.

AREAPCT.FRP Uses the same elements as the standard area percent report so you can 
customize your area percent reports.

LIBRARY.FRP A customized report that uses library search results. You must have a 
method loaded that specifies the spectra library.

Print Preview button
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ChemStation Views
Verification (OQ/PV) View

The Verification (OQ/PV) view allows an Agilent service engineer to test 
whether your analytical instruments and the ChemStation software are 
operating correctly according to predefined performance criteria.

• Operation Qualification (OQ)

Operation Qualification is the documented verification that the equip-
ment-related system or subsystem performs as intended throughout repre-
sentative or anticipated operating ranges.

• Performance Verification (PV)

Performance Verification is the documented verification that the process 
and or the total process-related system performs as intended throughout all 
anticipated operating ranges.

Title Bar

Message Line

Start/Stop Run

Sampling Diagram

Verification Toolbar System 
Diagram

Online Plot

Method Overview

View Selection

Task Selection 
Menu
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ChemStation Views
System Diagram Each icon of the system diagram represents one component or module of your 
system.

Verification
Toolbar

The Verification toolbar is displayed when you select Show Top Toolbar from 
the View menu. Move the cursor over a button to view a description of it.

Available Tests The following verification tests are supplied with your ChemStation software 
for use by an Agilent service engineer. Refer to the online help for more 
information on these tests.

• VWD Wavelength Accuracy

• Intensity

• Holmium

• Temperature Accuracy

• Noise, Flow, Temperature

• DAD Wavelength Accuracy

• Injector Precision*

• Detector Linearity/Carry-over*

• Injector Linearity*

• Gradient Composition

__________________________________________________________

*  These tests can be used to verify LC/MS quad performance.
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ChemStation Views
Diagnosis View

This view allows you to carry out diagnostic and maintenance activities on 
your system.

Diagnosis Toolbar The Diagnosis toolbar is displayed when you select Show Top Toolbar from 
the View menu. Move the cursor over button to view a description of it.

Title Bar

Instrument 
Panel

Symptoms Cause 
Information Pad

Possible Causes

Variables Display

View 
Selection

Message Line

Task 
Selection 
Menu
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ChemStation Views
MSD Tune View

MSD Tune Toolset

This toolset is present in MSD Tune view. 

Title Bar

View Selection

Message Line

MSD Tune Toolbar Status Bar

File Selection

Load an LC/MS quad tune file. Calibrate the mass axis.

Save the current tune file. Change spray chamber 
parameters.

Generate a profile and scan report. Edit LC/MS quad parameters for 
manual tuning.

Autotune the LC/MS quad and 
print a tune report.

Acquire multiple scans and send 
results to data file.
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Basic Operation
Basic Operation

Start up and Shut Down the System

Task Instruction Comment

To start up the system 1 From the Method and Run Control 
view, click the On button in the system 
diagram.

2 Set up the LC conditions (pump, 
column heater, and detector).

3 Set up the LC/MS quad spray chamber 
conditions as described in the MSD 
Spray Chamber dialog box topic in the 
online help.

Allow 15 minutes for the system to warm 
up.

This procedure assumes the system is 
under vacuum and the LC and LC/MS 
quad are properly connected. It also 
assumes the liquid flow path is 
properly set up.

To put the system in Standby Mode 1 Flush the system with pure mobile 
phase to ensure the flow path is clear 
of buffers. This avoids plugging the 
nebulizer. A plugged nebulizer can 
cause a high back pressure, which can 
damage the LC flow cell.
It is good practice to flush the flow 
path (including the column) for 5-10 
minutes with a mobile phase without 
buffers such as 50:50 
water/acetonitrile.

2 Click the Off button in the system 
diagram. All modules are set to 
standby mode (indicated by the gray 
color in the system diagram).
Standby for the LC/MS quad is 20 psi 
for the nebulizer, 3 L/min for drying 
gas, 300°C for drying gas temperature 
and, if present, 325°C for the APCI 
vaporizer. Also, the MS stream 
selection valve is set LC to Waste.

Put the system in standby mode 
overnight or whenever you won’t be 
analyzing samples for an extended 
time. The standby state for the LC/MS 
quad leaves the nebulizer and drying 
gas on at low flow.
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Basic Operation
Tune the LC/MS quad
When the LC/MS quad is used as a detector for the LC, a mass spectrum is 
associated with each data point in the LC chromatogram. To obtain high 
quality, accurate mass spectra, the LC/MS quad must be optimized to:

• Maximize sensitivity 

• Maintain acceptable resolution

• Ensure accurate mass assignment

Tuning is the process of adjusting LC/MS quad parameters to achieve these 
goals. After the LC/MS quad parameters have been optimized, they must be 
saved in a tune file (.tun). This tune file is then specified in the method that is 
used to acquire data for your samples.

Frequent tuning, automated or manual, is not required. Once tuned, the 
LC/MS quad is very stable. Tuning should generally be needed no more often 
than monthly, weekly at most.

Wait ~12 hours after pumpdown before tuning or operating your LC/MS quad. 
The analyzer takes about 12 hours to reach thermal equilibrium. Tune files 
that are created or data that is acquired before the LC/MS quad is at thermal 
equilibrium may have incorrect mass assignments and other inaccuracies.

Task Instructions Comments

To use Autotune 1 From the MSD Tune view, select 
Autotune from the Tune menu or click 
the Autotune toolbar button.

2 Review the tune report that is printed 
automatically when tuning is 
completed.

Use autotune for automated 
adjustment of the LC/MS quad 
performance.
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Basic Operation
To use Check Tune 1 Select Check Tune from the Tune 
menu.

2 Review the Check Tune report. 
Adjustments are suggested for values 
that are outside of acceptable ranges.

Use Check Tune to quickly determine 
whether the LC/MS quad is correctly 
tuned. It performs a single profile scan 
of the tune masses and compares the 
peak widths and mass axes with target 
values.

To use Manual Tune 1 Select Manual Tune from the Tune 
menu.

2 Set the desired mass resolution 
(adjusting width gain and width 
offset).

3 Calibrate the mass axis (adjusting 
mass gain and mass offset).

4 Optimize the ion transmission through 
the source ion optics (fragmentor, 
skimmer(s), lens 1, lens 2, octopole 
peak and octopole knee).

5 Adjust the signal strength (setting iris 
and adjusting the multiplier gain).

Note that fragmentor and gain are 
method parameters. The fragmentor 
affects ion transmission and 
fragmentation. For more information, see 
the online help.

Use Manual Tune when you want to:

• Achieve maximum sensitivity by 
sacrificing some resolution

• Tune specifically for the very low 
end (<150 amu) of the mass range

• Tune with a compound other than 
the standard calibrants

Task Instructions Comments
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Basic Operation
Acquire LC/MS Data

Modes of Acquisition

There are three modes of acquiring data:

• Running a method for a single sample

• Running a sequence for multiple samples

• Running an FIA series

Note the following about acquiring data:

• All three acquisition modes require an appropriate method.

• Samples may be injected either manually or with an ALS.

• A run must always be started from the software.

• An FIA method cannot be used in a sequence but multiple FIA methods can 
be run sequentially.
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Basic Operation
To edit a method and start a run

Once you know the acquisition mode you want to use, you need to set up an 
appropriate method. Methods are set up in the Method and Run Control view.

Instructions Comments

1 Select Method / Load Method or click the Open 
Method button on the toolbar. Select a method from 
the list.

2 Select Method / Edit Entire Method. This menu item 
is also available when you click the method icon on the 
system diagram.

3 Select the method sections you want to edit (select all 
sections to become familiar with the method 
parameters that are available).

4 Add any method comments you want to appear on 
your reports.

5 Set up the instrument parameters:
• set up the pump parameters
• set up the injector parameters
• set up the DAD (or VWD) parameters
• set up the column thermostat parameters
• set up the MS quad signals
• set up the MS quad spray chamber

6 Set up the Data Analysis parameters:
• set up the signal details
• edit integration events
• specify report parameters
• select the instrument curves
• select the calibration curves
• set up the calibration table
• find the ion parameters

7 Complete the Run Time Checklist.

A series of dialog boxes is displayed, 
which allows you to set up your 
method and instrument parameters.
Click the Help button on any of the 
following dialog boxes for descriptive 
information on the items available.

8 Save the method using a different name. Select 
Method / Save Method As or click the Save Method 
button on the toolbar.

Once you are familiar with the options 
that are available, you can use the 
system diagram menus for quick 
access to particular method 
parameters, rather than using the edit 
entire method process.

9 When you are ready to begin a run, click the Start 
button.
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Basic Operation
Use Deconvolution
Deconvolution is a process that transforms mass spectra from 
multiply-charged ions into a calculated molecular weight.

To deconvolute a mass spectrum

Instructions Comments

1 In the Data Analysis view, load an electrospray MS 
data file. The TIC is displayed. 

2 Generate the MS spectrum that you want to 
deconvolute (select the Spectral task tool set and use 
the spectrum selection tools to pick the spectrum of 
interest). 

3 Click the Enter Deconvolution Tool button to 
set up the deconvolution display area.

4 When the spectrum is displayed, click the 
Find Ions button to locate masses to be used 
in deconvolution. 

Note that these operations are 
performed on data acquired in full scan 
mode.

5 Examine the ions that were found. Very noisy 
data or data with unresolved regions often 
need special settings to find ions. 

6 Click the Edit Deconvolution Parameters 
button to change any of the parameters.

You can use the Find Ions Options 
button to optimize the set of ions 
found.

7 Click the Run Deconvolution button to begin 
the deconvolution process. 

Once the deconvolution is done, the 
components are displayed in the upper 
right window. The charge states are 
displayed in the lower right window.

8 Select specific components from the Component list to 
look at individual components or groups of 
components. 

Optionally, click the Preview 
Deconvolution Report 
button 
or click the Print Report 
button.

9 Optionally, select components from the 
Component List box and then click the 
Delete Components button. 

10 Repeat the process. 

This action removes the peaks for the 
selected components from the original 
spectrum. You can then continue with 
step 4 above, using this new spectrum. 
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Basic Operation
Deconvolution Report

The Deconvolution report contains summary information about each 
component selected, along with detailed information on how each peak in a 
component contributes to the component's molecular weight. In the first part 
of the report, the components are ranked by percent relative abundance, 
which is useful for estimating the percent of impurities.

Note that the actual molecular weight may differ from the computed molecular 
weight even if the data fit a Gaussian curve perfectly, due to other errors such 
as errors in mass axis assignment or unresolved chemical impurities.

The Deconvolution software is optional and is part of the G2720AA 
Bioanalysis Software package.
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Operating Tips
Operating Tips

• Back up your data and methods regularly to avoid loss of data if the files 
are accidentally overwritten, deleted, or if a hardware problem develops 
with your disk drive.

• Put the system in standby mode overnight or whenever you won’t be 
analyzing samples for an extended time.

• Verify that the tune file you are using is appropriate for your samples.

• Save Tune reports in an MS Logbook for future reference.

• Regular system maintenance can reduce problems. Keep a maintenance 
record.

• Use the Maintenance Logbook and EMF features in Diagnosis view to help 
you keep track of when maintenance is needed and to keep an online 
maintenance record.

• Flush the sample path and clean the spray chamber, capillary tip, and spray 
shield daily or at the end of each shift. Check the foreline pump fluid level 
every week.

• The spray chamber vent hose must be connected to a lab vent that is used 
only for the source (completely separate from the vent hose for the foreline 
pump). Otherwise, waste products can migrate into the spray chamber vent 
producing chemical noise.

• Samples need to be filtered. They should be salt and detergent-free if no 
chromatography is used.

• If a UV detector is available, use it in series with the LC/MS quad. Try to 
minimize chromatographic peak broadening by using low dispersion tubing.

• To avoid chromatographic band broadening, be sure that all tubing 
connections are free of dead volume. Use zero dead-volume (ZDV) fittings 
when possible.

• Use finger-tight fittings on the LC inlet union. Swaged fittings can compress 
the frit.

• If you are using APCI, the optimal flow rate is 1.0 ml/min. The range is 0.5 
to 1.5 ml/min.
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Operating Tips
• Use the following table as a guide to using SIM, condensed scan, and full 
scan acquisition modes.

Task Mode

Acquire electrospray data for samples containing large, 
multiply-charged analytes.

Full Scan

Analyze a mixture with unknown components (small molecules). Scan

Analyze a mixture with known components in unknown amounts 
(quantitate).

Scan or SIM

Identify the presence of a few known compounds at low levels within 
a mixture.

SIM

Use fast chromatography on SL MS quads without missing peaks. Fast Scan

Use fast chromatography on 6140A SL-HT MS quads without missing 
peaks.

Ultra Fast Scan
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Troubleshooting Tips
Troubleshooting Tips

No peaks

✔ Verify that there is spray from the nebulizer.

✔ Verify that the capillary voltage is set correctly.

✔ Verify that the LC/MS quad is tuned correctly.

✔ Verify that LC/MS quad pressures are within normal ranges.

✔ Check the drying gas flow and temperature.

✔ Verify that the fragmentor is set correctly.

Poor mass accuracy

✔ Recalibrate the mass axis.

✔ Verify that the ions used for tuning span the mass range of the sample ions 
and that they show strong, stable signals.

Low signal

✔ Check the solution chemistry. Verify that the solvent you’re using is 
appropriate for your sample. Mixed samples can exhibit signal suppression 
of one or more components.

✔ Verify that the sample is fresh and has been stored correctly.

✔ Verify that the LC/MS quad is tuned correctly.

✔ Check the nebulizer condition.

✔ Clean the capillary entrance.

✔ Check the capillary for damage and contamination.
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Troubleshooting Tips
Unstable signal

✔ Verify that the drying gas flow and temperature are correct for the solvent 
flow you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic 
degassing with protein samples.

✔ Verify that the LC backpressure is steady; this indicates a steady solvent 
flow.

High spectral noise

✔ Use appropriate mass filter values.

✔ Check the spray shape. Nebulizer may be damaged or incorrectly set.

✔ Verify that drying gas flow and temperature are correct for the solvent flow 
you are using.

✔ Verify that the solvent is thoroughly degassed. Do not use ultrasonic 
degassing with protein samples.

✔ Verify that the LC backpressure is steady; this indicates a steady solvent 
flow.

✔ If you are using water as part of the mobile phase, verify that it is 
de-ionized (>18MΩ).

Droplets, not spray, exiting the nebulizer

✔ Verify that the nebulizing gas pressure is set high enough for the LC flow 
being used.

✔ Check the position of the needle in the nebulizer.

✔ Stop the solvent flow and remove the nebulizer assembly. Use a magnifying 
glass to examine the end of the nebulizer for damage.
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Troubleshooting Tips
No flow

✔ Verify that the LC is on and there is sufficient solvent in the correct bottle.

✔ Check for LC error messages.

✔ Check for blockages. Repair or replace any blocked components.

✔ Check for leaks.

✔ Verify that the MS stream selector valve is set to LC to MSD.

Undesired fragmentation

✔ Fragmentor is set too high.

✔ Ionization is causing fragmentation (APCI vs. Electrospray).

✔ APCI temperature is too high.
Agilent 6100 Series Quad LC/MS Systems Quick Start Guide 31



Safety Warnings
Safety Warnings

Intended Purpose

Use of the LC/MS quad in a manner not intended by the manufacturer is 
prohibited.

Safety Class

The LC/MS quad is a Safety Class 1 instrument and has been designed and 
tested in accordance with IEC Publication 1010-1, Safety Requirements for 
Electrical Equipment for Measurement, Control, and Laboratory Use.

Stack Configuration

Placing the LC modules on top of the LC/MS quad is also inconvenient. It puts 
the solvent bottles and some LC controls out of easy reach and requires the LC 
stack to be disassembled and removed for LC/MS quad maintenance.

WARNING While it is possible to stack the LC modules on top of the LC/MS quad without 
damaging it, this arrangement is potentially unstable and dangerous and is not 
recommended.

WARNING Use only Nitrogen as the drying and nebulizer gas. Air, oxygen, or other gases, when 
combined with solvents and high voltages in the spray chamber, can result in an 
explosion.

WARNING Do not connect the LC/MS quad to a power source that is not equipped with a 
protective earth contact. You can create a shock hazard for the operator and can 
damage the instrument.

WARNING Do not interrupt the protective conductor inside or outside the LC/MS quad or 
disconnect the protective earth terminal. You can create a shock hazard for the 
operator and can damage the instrument.
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Safety Warnings
WARNING Do not adjust, maintain, or repair the opened instrument while it is connected to a 
power source. These operations should be performed only by trained persons who 
are aware of the hazards involved.

WARNING Before you perform maintenance on the electronics or turbo controllers, turn off the 
main circuit breaker and disconnect the power cord. The power switch on the front 
of the LC/MS quad does not completely cut power to the instrument.
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Safety Warnings
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Safety Warnings
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